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Preface

Thank you for purchasing Multifunctional Digital Color Systems. This manual explains the instructions for N/W-Fax Driver. 
Read this manual before using your Multifunctional Digital Color Systems. Keep this manual within easy reach, and use it 
to configure an environment that makes best use of the this equipment’s functions.

How to read this manual

Symbols in this manual
In this manual, some important items are described with the symbols shown below. Be sure to read these items before 
using this equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with 
the following signage:

Screens
Screens on this manual may differ from the actual ones depending on the use-environment of the equipment such as 
the installing status of options.
Screens of when paper in the A/B format is used are given in this manual. If you use paper in the LT format, the display 
or the order of buttons may differ from that of your equipment.

Trademarks
The official name of Windows 2000 is Microsoft Windows 2000 Operating System.
The official name of Windows XP is Microsoft Windows XP Operating System.
The official name of Windows Vista is Microsoft Windows Vista Operating System.
The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.
The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.
Microsoft, Windows, and the brand names and product names of other Microsoft products are trademarks of Microsoft 
Corporation in the US and other countries.
Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, TrueType, and LaserWriter are trademarks of Apple Inc. in the US 
and other countries.
Adobe, Adobe Acrobat, Adobe Reader, Adobe Acrobat Reader, and PostScript are trademarks of Adobe Systems 
Incorporated.
Mozilla, Firefox and Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and other 
countries.
IBM, AT and AIX are trademarks of International Business Machines Corporation.
NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
Other company names and product names in this manual are the trademarks of their respective companies.

Indicates a potentially hazardous situation which, if not avoided, could result in death, serious 
injury, or serious damage, or fire in the equipment or surrounding assets.

Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate 
injury, partial damage to the equipment or surrounding assets, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Describes handy information that is useful to know when operating the equipment.

Pages describing items related to what you are currently doing. See these pages as required.
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1.OVERVIEW

This section describes about the overview of the network fax features.
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Features and Functions

This equipment provides the network fax feature, which simplifies and facilitates your office facsimile needs that enables 
you to send fax or Internet Fax digital documents directly from your desktop.

Fax transmission using the N/W-Fax driver is available only when the optional Fax unit is installed.
Please enable the SNMP setting on COMMAND CENTER to use the N/W-Fax functions. In addition, the N/W-Fax 
driver does not work if the SNMP setting on COMMAND CENTER is disable when the optional Fax unit is installed.

Functional highlights
The highly intuitive, network N/W-Fax driver software enables you to select the fax printer driver to electronically faxes or 
Internet Faxes from your computer to one or more recipients. You can easily define fax job properties from the send list to 
fax resolutions. The N/W-Fax driver is complimented with the AddressBook Viewer. The combination of applications 
enables you to easily manage a selection of fax recipients and access to the address book.

The N/W-Fax driver enables you to set up send lists and send electronic documents from your PC to one or more 
destinations. You send to the fax much the same way you would choose to print to a designated printer that makes using 
the N/W-Fax driver quick and simple. You can select the fax properties. Fax properties are the attributes you can set to 
define sender and recipient information for processing fax jobs such as dialing options, sender information, fax resolution 
and page layout.
Other features include an easy to use fax scheduler that allows you to set up a date and time to transmit your fax. Cover 
page options are also provided. You can include a customized cover page with your fax transmission that can include 
sender and recipient fax information and a detailed message. You can easily maintain sender and contact information that 
can be printed on the cover pages.

Faxing hard-copy documents must be performed from the touch panel display.

The image quality of the originals that are sent by the N/W-Fax driver is different from the originals that are sent by 
the general fax operation.
If you specify the email addresses as the recipients using N/W-Fax driver, the document will be sent as an Internet 
Fax. The Internet Fax feature allows users to send originals, same as the fax features. However, the Internet Fax is 
sent through the Internet, although the fax is sent through the public switched telephone line. In order to send the 
Internet Fax, the remote device also must support the Internet Fax feature.
For more details about the Internet Fax, refer to the Scanning Guide.
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This section describes the instructions on how to send a fax using the N/W-Fax driver.

How to Fax using the N/W-Fax Driver .................................................................................... 8
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Faxing from Windows applications.........................................................................................................................8
Specifying recipients.............................................................................................................................................11
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How to Fax using the N/W-Fax Driver

The following outline summarizes the steps for sending a fax from your desktop:
Create a document.
Print to Fax Driver.
Add recipient’s name and fax numbers.
Select a default cover page (optional).
Send the fax.

Preparing documents for faxing
To see how objects, such as headers, footers, or drawing objects, will be positioned on a fax page, switch to your 
applications’ page layout view. If the software application you are using provides a Print Preview option, you can use it to 
view your fax before it is sent.

Faxing from Windows applications
Once you have installed the N/W-Fax driver, you can send the document directly from most Windows applications as a fax 
or Internet Fax.
You can print using various functions by setting print options on the printer driver.

If you want to specify the recipients using the AddressBook Viewer, add the contacts to the AddressBook Viewer 
first.
You can specify up to 400 recipients in a single operation. Moreover, you can send the document to faxes and 
Internet Faxes at a same time.   However, if the cover page is set to be sent or the header page is set to be printed 
on the recipient’s devices, all recipient’s addresses will be printed. If you want to secure the recipient information, 
send the Internet Fax separately to each recipient rather than sending to the multiple recipients at the same time.

Faxing from Windows applications

Windows Vista is used in the procedure below but it basically the same for other Windows OSs.

1 Open a file and select [Print] from the [File] menu of the application.
The [Print dialog] box appears.

2 Select [HS Series Fax] and click [Preferences].

The [Properties] dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different depending on the 
application you are using. See your application’s manual about displaying the [Printer properties] dialog 
box.
[Preferences] is displayed instead of [Properties] in the [Print] dialog box depending on an application.
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3 Click the [Send] tab and specify the recipients, and other options.

You must specify the recipients to send a document as a fax. For instructions on how to specify the 
recipients, see the following section.

 P.11 “Specifying recipients”
For other settings on the Send tab, see the following section.

 P.21 “Setting the Send properties”

4 When you want to send a document with a fax cover sheet, click the [Cover Sheet] tab, 
select the cover sheet type in the [Cover Sheet] box and specify the other options.

If you select the [Sender Information] option, continue to the next step and specify the message to appear as the 
sender information. Otherwise, skip to step 6.

For instructions on how to set the [Cover Sheet] tab, see the following section.
 P.22 “Setting up the Cover Sheet properties”
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5 When you select the [Sender Information] option in the [Cover Sheet] tab, click the 
[Sender Information] tab and enter the sender information message to appear on the 
fax cover sheet.

In the text box in the [Sender Information] tab, you can enter up to 500 characters.

For instructions on how to set the Sender Information, see the following section.
 P.23 “Setting up the Sender Information properties”

6 Click [OK] to save the settings.

7 Click [OK] to send a document.

You can monitor and manage the fax job that is sent from your computer using COMMAND CENTER.
[OK] is displayed instead of [Print] in the print dialog box depending on an application.

When you use the N/W-Fax driver to send a fax job, check whether the job has been successfully sent on the 
“Logs - Transmission” screen in COMMAND CENTER.
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Specifying recipients
You can specify the recipients following method:

 P.11 “Specifying recipients from address book”
 P.14 “Searching recipients from address book”
 P.17 “Entering a recipient manually”

Also you can remove the recipients added to the “To” list.
 P.18 “Removing recipients”

Specifying recipients from address book

1 Click [Select From Address Book] in the [Send] tab.

The AddressBook Viewer is launched.
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2 Browse the address book category within the address book where desired recipients 
are programed.

Private Address Book — This contains the contacts registered in the associated client address book on your 
client computer. Up to 200 groups in “Group”, 2000 contacts in “Location/People” and 2000 contacts in total of 
“Group” and “Location/People” can be registered.
Public Address Book — This contains the contacts registered in the address book in this equipment.
MAPI Address Book — This contains the contacts in the address book of the default mail client in your computer. 
The display varies depending on the type of Microsoft mailer which you use.
Windows Mail Address Book — This contains the contacts in the MS Outlook Express address in your client 
computer. Up to 2000 contacts can be downloaded in the “Location/People” folder. If the contacts exceed 2000 
contacts, only 2000 contacts can be downloaded and other contacts are ignored.
The display items differs according to the Microsoft mail application.
LDAP Address Book — This contains the contacts in the specified LDAP server. Up to 2000 contacts in “Location/
People” can be registered.
Import Address Book — If the address book data has been imported from a CSV file or vCard file, this address 
book will be displayed.

For more information about the AddressBook Viewer, refer to the AddressBook Viewer Online Help.
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3 Select the contact you want to add as a recipient and click the [Fax] icon ( ) in the 
toolbar to add the fax number as a recipient, or click the [Mail] icon ( ) to add the e-
mail address as a recipient.

Repeat until all required recipients are selected.
When you select the fax number as a destination, the fax number icon before the name of the contact will be 
changed to the checked fax icon ( ).
When you select the e-mail address as a destination, the e-mail icon before the name of the contact will be 
changed to the checked e-mail icon ( ).

You can cancel selecting the fax number or e-mail by selecting the contact and re-clicking the [Fax] or [Mail] 
icon in the toolbar.
You can also select the recipient’s fax number by right-clicking the contact and select [Select] and [Fax 
Number] in the menu displayed.
You can also select the recipient’s e-mail address by right-clicking the contact and select [Select] and [E-
Mail] in the menu displayed.

4 After you selected all recipients, right-click on a recipient name in the right pane and 
select [Selection] in the menu displayed.

The [Destinations] dialog box appears.

You can also display the [Destinations] dialog box by clicking the [Selection] icon ( ) in the toolbar.
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5 Confirm the destinations that you selected in the dialog box. If you wish to remove a 
destination from the recipients list, select the contact and click [Remove].

6 After you confirm the destinations, click [OK].

7 The AddressBook Viewer is closed and selected recipients are added to the [To] list.

Searching recipients from address book

1 Click [Select From Address Book] in the [Send] tab.

The AddressBook Viewer is launched.
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2 Click the [Edit] menu and select [Find].

The [Find Contact] dialog box appears.

3 Select an address book to search contacts in the [Data Source] drop down box.

The default address book in the [Data Source] can be set by selecting [View] - [Default Configuration] - [Data 
Source] from the menu bar.

4 Click the [Person] tab and enter search text in the following boxes that you require.

Display Name — Enter the search characters or string to search by the first name.
Fax Number — Enter the search characters or string to search by the contact fax number.
E-Mail — Enter the search characters or string to search by the contact e-mail address.

You must enter one of the box to search contacts. It will search the contacts that have exactly same name, fax 
number, or e-mail address as the entered search strings.

If you want to clear entered values, click [Clear All].
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5 Click [Search].
It begins searching contacts in the selected address book. When it completes searching, found contacts appear in 
the list at the bottom of the dialog box.

If you want to stop searching, click [Stop].

6 Select the searched contacts and click [Address].

The [Type Selection] dialog box appears.

7 Select the [Email Address] check box if you want to add the Email address of the 
selected contacts as the destinations, and select the [Fax Number] check box if you 
want to add the fax number of the selected contacts as the destinations.

The default destination type in the [Type Selection] dialog box can be set by selecting [View] - [Default 
Configuration] - [Type Selection] from the menu bar.

8 Click [OK].
The [Destinations] dialog box appears.

9 Click [OK].

The selected contacts are added as recipients for N/W-Fax.
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10 The [Destinations] dialog box is closed and selected recipients are added to the [To] 
list.

Entering a recipient manually

1 Click [New].

The [Direct Dial] dialog box appears.

2 To add an Internet Fax address as a recipient, select [Internet Fax Address] and enter 
the e-mail address of the recipient in the right box.

To add a fax number as a recipient, select [Fax Number] and enter the fax number in the 
right box. In addition, if you specify a Sub address, enter the Sub address in the [SUB] 
box, and security password for the Sub address in the [PWD] box if required.

You can send to a fax number only when the optional Fax unit is installed.
Use “-”(hyphen) if you send from the N/W-Fax and want to insert pauses in the Fax number.
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3 Click [OK].
Entered recipient is added to the [To] list.

Removing recipients

1 Select a recipient that you want to delete from the [To] list.

2 Click [Remove].
The selected recipient is deleted from the [To] list.
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This section describes how to set up options for N/W-Fax driver.
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How to Setup

There are several ways to set the N/W-Fax driver options. How the settings effect varies depending on the way you set the 
options.

Setting Initial Values of N/W-Fax driver options
Setting the N/W-Fax options by displaying the N/W-Fax driver properties from the Printers folder on the Windows [Start] 
menu will establish the initial values of the options.

How to display

1 Click [Start], [Control Panel] and select [Printers].
When using Windows 2000/XP/Server 2003, click [Start] and select [Printers and Faxes].

2 Select the N/W-Fax driver, click the [File] menu and select [Printing Preferences].

Setting print options for each print job
Setting the N/W-Fax driver options by displaying the printer properties from the Print dialog box within an application will 
establish the values for the current N/W-Fax job. The N/W-Fax driver option settings specific to each N/W-Fax job are set 
using this method.

How to display:

1 Click the [File] menu and select [Print] on an application.

2 Select [HS Series Fax] and click [Properties] or [Preferences].
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Setting up the N/W-Fax Options

N/W-Fax options are the attributes to define the way a fax job is transmitted. For example, you can specify the recipients, 
resolution, and paper size.

For additional instructions concerning these fax transmission settings, refer to the procedures in the following section.
 P.24 “Sending with Extended Fax Functionality”

Setting the Send properties
In the [Send] tab of the [N/W-Fax properties] dialog box, you can specify the recipients and how the fax will be sent.

To specify the recipients, you can select from the address book or enter the recipient manually.
 P.11 “Specifying recipients”

1) To
This displays the specified recipients list.

2) [Select From Address Book]
Click to launch the AddressBook Viewer. You can select recipients from the address book.

 P.11 “Specifying recipients from address book”

To use the address book, you must register the contacts using the AddressBook Viewer.

3) [New]
Click to add new recipient by entering manually. The [Direct Dial] dialog box appears.

 P.17 “Entering a recipient manually”

4) [Remove]
Select a recipient in the [To] list and click this to remove the recipient from the list.

 P.18 “Removing recipients”

5) Resolution
Select the resolution for the fax.
- Standard (200 x 100 dpi) — Select this to send a document in Standard mode (200 x 100 dpi).
- Fine (200 x 200 dpi) — Select this to send a document in Fine mode (200 x 200 dpi).
- Super Fine (200 x 400 dpi) — Select this to send a document in Super Fine mode (200 x 400 dpi).
- Ultra Fine (400 x 400 dpi) — Select this to send a document in Ultra Fine mode (400 x 400 dpi).

6) Dept. Code
Enter 5-digit department code if required. When the department code is enabled on this equipment, you must enter the 
department code to send a fax.

3

4
6
8

10

1

2
5
7
9

11
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If you do not enter the department code when the department code is enabled on the equipment and the 
Department Code Enforcement is set to OFF in COMMAND CENTER, the job will be stored in the Invalid job 
list without transmitting the job. You can release or delete the job that is stored in the Invalid job list from the 
[JOB STATUS] button on the touch panel. For instructions on how to release or delete the job in the Invalid job 
list, refer to Printing Guide.
If you do not enter the department code when the department code is enabled on the equipment and the 
Department Code Enforcement is set to PRINT in COMMAND CENTER, the job will be sent.
If you do not enter the department code when the department code is enabled on the equipment and the 
Department Code Enforcement is set to DELETE in COMMAND CENTER, the job will be deleted automatically.

7) Paper Size
Select the paper size of your document.

8) Orientation
Select the orientation of your document.

9) Save as File
Select this to save up to 10 GB documents in the “FILE_SHARE” folder in the equipment as well as send the document 
as a fax and Internet Fax.

 P.24 “Saving a fax as file”

When the Cover Sheet is set, the Cover Sheet and the original will be stored in the “FILE_SHARE” folder.

10) File Format
Select the file format of the document that will be saved. This option can be selected only when the “Save as File” box 
is selected.

11) Delayed Fax
Select whether sending a document now or later.
- Send Fax Now — Select this to send a document immediately.
- Send Fax Later — Select this to send a document on a specified date and time. When this is selected, click [Edit] 

to display the Scheduled Time dialog box and specify date and time the job will be transmitted. The job sent to this 
equipment will be stored in the Fax queue until the specified date and time.

 P.24 “Sending a document on specific date and time”

Setting up the Cover Sheet properties
In the [Cover Sheet] tab of the [N/W-Fax properties] dialog box, you can specify the fax cover sheet to be sent. If you 
enable the cover sheet, the cover sheet is attached in the first page of the document and sent to the recipients.

 P.25 “Preparing the cover sheet”

1) Cover Sheet
Select the cover sheet type from [Standard Cover Page], [Business Cover Page], and [Professional Cover Page]. For 
cover sheet samples, see the Appendix at the end of this guide.

2) Font Name
Select the font to be used for the cover sheet.

1
2
3
4

5
6

7
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3) Subject
Enter the subject to be displayed on the cover sheet. You can enter up to 40 characters.

4) Message
Enter the message to be displayed on the cover sheet. You can enter up to 500 characters.

5) Sender Information
Check this to print sender information on the cover sheet. When this is enabled, specify the sender information in the 
Sender Information tab.

 P.23 “Setting up the Sender Information properties”

6) Recipient Information
Check this to have recipient information appear on the cover sheet. Select one or more of the following options to 
determine what information will appear in the [To:] field of the cover sheet.
- Name — Check this to have the recipient name appear on the cover sheet.
- Company — Check this to have the recipient company name appear on the cover sheet.
- Department Name — Check this to have the recipient department name appear on the cover sheet.
- Fax Number — Check this to have the recipient fax number or Internet Fax address appear on the cover sheet.

7) Reference Number
Enter the reference number to identify the fax. This number will appear on the cover sheet.

Setting up the Sender Information properties
In the [Sender Information] tab of the [N/W-Fax properties] dialog box, you can specify the sender information that appears 
on the cover sheet. This must be set only when the “Sender Information” box in the Cover Sheet tab is selected.
In the text field in the Sender Information tab, you can enter up to 500 characters.

Displaying the Version Information
In the [About] tab of the [N/W-Fax properties] dialog box, you can display the version information of the N/W-Fax driver.
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Sending with Extended Fax Functionality

The N/W-Fax driver allows users to perform the following features.
 P.24 “Saving a fax as file”
 P.24 “Delayed transmission”
 P.25 “Sending with a cover sheet”

Saving a fax as file
You can save a document in the “TXFAX” folder in the “FILE_SHARE” folder in this equipment as well as sending the 
document to fax numbers and Internet Fax addresses.

Saving a fax to the default box

1 Display the [Send] tab and select the [Save as File] box.

2 Select the file format in the [File Format] drop down box.

3 Specify the other options to send a document and click [OK].

4 Click [OK] (or [Print]) to send a document to this equipment.
The document is saved in the “TXFAX” folder in the “FILE_SHARE” folder in this equipment.

The saved file contains the cover sheet when the cover sheet is set.

Delayed transmission
When the delayed transmission is specified, the fax is stored in the fax queue in this equipment and will be sent on the 
specified date and time.

Sending a document on specific date and time

1 Display the [Send] tab and select [Send Fax Later] in the [Delayed Fax] drop down box.

2 Click [Edit].
The [Scheduled Time] dialog box appears.
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3 Select the date and time and click [OK].

You can click the Date arrow to display a calendar then allows you to select an date.
Enter the time to commence the fax transmission. You can use the up and down arrows to assist with setting 
the time with the proper format.

The scheduled date cannot be more than one month from the current date. If the current month does not have 
a date like the current date, then the date will be set at the last day of the following month. For example, if the 
current date is March 31st. then the maximum date that can be selected for the scheduled fax is April 30th.

4 Specify the other options to send a document and click [OK].

5 Click [OK] (or [Print]) to send a document to this equipment.

Sending with a cover sheet
You can choose to send a cover sheet with your fax transmission. The cover sheet is merged with the recipient [To] list 
data to create a fax cover sheet. You can select what to include on the cover sheet such as sender or recipient 
information.

Preparing the cover sheet

1 Display the [Cover Sheet] tab and select the cover sheet type in the [Cover Sheet] box.

For samples of the cover sheets, see the Appendix at the end of this guide.
 P.32 “Cover Sheet Samples”

2 Select the font in the [Font Name] box.

The selected font applies to the text contents in the cover sheet.

3 Enter the subject to be displayed on the cover sheet in the [Subject] box.

You can enter up to 40 characters for the subject.

4 Enter the message to be displayed on the cover sheet in the [Message] box.

You can enter up to 500 characters for the message.
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5 If you want the sender information to appear on the cover sheet, select the [Sender 
Information] box.

If you check this, click the [Sender Information] tab and enter the sender information in the text box. You can enter 
up to 500 characters in the sender information text box.

6 If you want the recipients information to appear on the cover sheet, check the 
[Recipients Information] box and check the items required for the recipient information.

Name — Check this to have the name of the recipient appear on the cover sheet.
Company — Check this to have the company name of the recipient appear on the cover sheet.
Department Name — Check this to have the department name of the recipient appear on the cover sheet.
Fax Number — Check this to have the fax number or Internet Fax address of the recipient appear on the cover 
sheet.

Recipients information is obtained from the address book. If the recipient is added manually, this information 
does not appear on the cover sheet except for the fax number or Internet Fax address.
The recipients information for all recipients will appear on the cover sheet.

7 If you want the reference number to identify the document to appear on the cover 
sheet, select the [Reference Number] box and enter the reference number in the box.

You can enter up to 20 characters for the reference number.

8 Specify the other options to send a document and click [OK].

9 Click [Print] to send a document to this equipment.
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This section describes about troubleshooting for printing features.
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4 TROUBLESHOOTING

28    N/W-Fax Driver Errors

N/W-Fax Driver Errors

For N/W-Fax driver Errors, refer to the following section.
 P.28 “N/W-Fax Driver Installation Error Messages”
 P.30 “N/W-Fax Driver General Errors”

N/W-Fax Driver Installation Error Messages

For information on the installation of the N/W-Fax driver, refer to the Operator’s Manual for Software Installation 
Guide.

Setup needs to copy Windows NT files

Problem description
The wrong port type was selected from the Printer Ports dialog.

Corrective action
1. Click Cancel until the Add Printer Wizard terminates.
2. Double-click Add Printer from the Printers folder but, when prompted to select a port, choose Local Port.

Client software CD now required

Problem description
When adding a new printer driver, the end user did not choose the Have Disk option; instead, the user selected the printer 
name from the Add Printer list.

Corrective action
1. Cancel the Add Printer Wizard.
2. Double-click Add Printer from the Printers folder but, when prompted to locate the driver, click Have Disk.
3. Select Use Existing Driver to add another copy of an existing driver or browse to the subdirectory that contains the 

appropriate *.inf file.

File *.DRV on client CD could not be found

Problem description
When adding a new printer driver, the user did not choose the Have Disk option but selected the printer name from the 
Add Printer list.

Corrective action
1. Cancel the Add Printer Wizard.
2. Double-click Add Printer from the Printers folder, but when prompted to locate the driver, click Have Disk.
3. Browse to the subdirectory that contains the appropriate *.inf file.

Location does not contain information about your hardware

Problem description
The path to the *.inf file selected during driver installation is too far away. In other words, there are too many characters in 
the directory path.

Corrective action
Copy the directory containing the *.inf file to the local drive and resume installation.
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This port is currently in use

Problem description
The driver was either opened, printing a job, or in use by another printer or application, when you attempted to delete it.

Corrective action
Make sure all print jobs have been completed before deleting a port. If there are still problems, exit all applications and try 
again. Check each driver to see if another driver is using the same port. If so, first change the driver’s port setting and 
delete the port.

Problem with the current printer setup

Problem description
The driver was not set up properly, possibly because the installation procedure was not completed.

Corrective action
Delete the driver and either reinstall it from the Client Utilities CD-ROM or download it from this equipment.
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N/W-Fax Driver General Errors

Driver mapped to wrong port

Problem description
If the N/W-Fax driver on a client workstation points to the wrong network port, jobs do not appear in the current jobs queue 
or cannot be printed out.

Corrective action
1. Open the Printers folder from the Control Panel.
2. Right-click the printer driver icon.
3. Select Properties from the shortcut menu.
4. Depending on the operating system, select the following tab:

- In Windows 2000/XP/Vista/Server 2003/Server 2008 — Select Ports. Add a new port and map it to the printer.
5. Make sure that the path to the printer and the device name are correct.

\\<device name>\print
- Where <device name> is the same as the device name set from the Touch Panel Display.

6. Click the General Tab and click Print Test Page to confirm that the settings are correct.

“Could not connect to the MFP device” appears

Problem description
When users are trying to access to the properties of the Network Fax driver, an error message “Could not connect to the 
MFP device” appears.

Corrective action
Communication between the Network Fax driver and this equipment failed. Make sure that this equipment is operating. If 
not, turn its power ON.
Connect the Network Fax driver with this equipment through the COMMAND CENTER. If connection fails, reboot the 
computer and this equipment.

The fax jobs are not listed on the “Logs - Send” “Logs - Transmission” 
screen in COMMAND CENTER

Problem description
When confirming the fax job logs on the “Logs - Send” “Logs - Transmission” screen in COMMAND CENTER, the fax jobs 
that sent are not displayed.

Corrective action
If the relevant fax job is not included in the Log list, your transmission job may not have been performed. In this case, 
search for jobs without the department code in the “JOB STATUS - FAX” on the control panel. Then, select the relevant fax 
job and press the [SEND] button to resend it.



5.APPENDIX

This section shows the cover sheet samples.

Cover Sheet Samples............................................................................................................. 32
Standard Cover Page ...........................................................................................................................................32
Business Cover Page...........................................................................................................................................33
Professional Cover Page......................................................................................................................................34



5 APPENDIX

32    Cover Sheet Samples

Cover Sheet Samples

Standard Cover Page

Reference Number: 
   0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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Business Cover Page

Reference Number: 
   0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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Professional Cover Page

Reference Number: 
   0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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